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Abstract 
 

Stereoscopy is a technique that can create an illusion of depth in a flat image. There 

are many different methods to do this, and here is explained some of the most 

common and popular ways, with a bigger focus on the anaglyphic method. Since 

stereoscopy is an old technique, the discovery of it by Charles Wheatstone is 

explained briefly. In Autodesk Maya 2009, a new stereoscopic plug-in was included 

which makes the creation of stereoscopic imagery easier. An animated project is 

made during the course of this research which takes advantage of and tests the 

functions of the new plug-in. The main purpose of the project is to create a 

stereoscopic movie which utilized the anaglyph stereoscopic technique. The result is 

rendered stereoscopic material that is edited with Adobe Premiere Pro to create 

anaglyphic imagery and a full color alternative using the Infitec technique. 

Keywords: stereoscopy, anaglyph, stereo, Maya 2009, plug-in, stereoCamera, 

Interaxial Separation, Zero Parallax 
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1 Introduction 

Stereoscopy is a technique that is being used to create an illusion of depth in an 

otherwise flat image. This is no new technique. It has been available in different 

implementations for over 170 years [1]. The focus in this research report will be on 

one certain technique that is used to reproduce stereoscopic material; the anaglyphic 

method. However, a few other techniques will also be explained to provide an idea of 

how stereoscopy can be used and experienced, and what the differences and 

similarities are between them. A significant part of this research is a project which will 

be performed during the course of this period to create a short animated stereoscopic 

movie, and will further on in this report be explained thoroughly. This project will be 

modeled and animated with Autodesk Maya 2009, and will during the animation and 

rendering take advantage of the new stereo plug-in included in Maya. The image and 

texture editing will be completed using Adobe Photoshop CS2. When the movie has 

been rendered the post-production will be performed with Adobe Premiere Pro 2.0. 

This is where the rendered imagery will be edited to be ready to be exported as an 

anaglyphic stereoscopic movie. The material will in addition to this be made available 

for display using the Infitec method. 

 

1.1 Purpose 

The main purpose of this research is to create a short animated movie. This will be 

accomplished by utilizing the new stereoscopic plug-in in Maya 2009. The movie will 

then be available for people that would like a demonstration of how the technique 

works and for those that wants to experience it on the screen. The project also has as 

purpose to explain how the stereoscopic technique works, and to obtain a more 

detailed look at the different methods that exists to reproduce stereoscopic material, 

with a greater focus on the anaglyphic method. It will also discuss the things that 

should be kept in mind when creating stereoscopic imagery, especially when it comes 

to the creation and rendering of modeled and animated material. 

 

2 Stereoscopy 

By using the stereoscopic technique to show material that is specifically made for this 

purpose, the eyes, or more correctly the brain, can be fooled into believing there is 

depth in the images that is being viewed. This works since each eye is presented with 

different images [2]. These images differ only slightly in perspective, and if the two 

images are viewed one by one, it is often hard to tell them apart. This is the same as 

with your eyes, since they are placed apart from each other, each eye experiences a 

slightly different perspective of natural objects. However, this is not called 

stereoscopy. It is instead referred to as binocular vision [3]. Stereoscopy, on the other 

hand, “relates to the artificial reproduction of similar effects” [3]. 

 

The distance between the human eyes is an important part of stereoscopic work, 

and is measured between the centers of the pupils as the interpupillary distance (IPD). 

It is the distance between the eyes that determines the degree of stereoscopy [3]. 

“However,” as Dodgson writes, “there is startlingly little agreement on what it should 

be. Mean IPD has been quoted in the stereoscopic literature as being anything from 

58 mm to 70 mm” [4]. The results further on in his article show that this measurement 

varies between ages, sexes, and different races for we are all built differently. 
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2.1 History 

As the stereoscopic technique was invented as early as 1838 there is some history 

behind its development [1]. Charles Wheatstone is the man that discovered the 

technique and at the same time he wrote an article which was published in 

Philosophical Transactions [5]. His article discusses the different discoveries that he 

made. The development progressed from his discoveries in several different directions 

and created many methods in which today we can experience stereoscopic material. 

 

In his article, Wheatstone explains that when we look at objects in a far distance, 

it does not matter which eye we look with, because the appearance of the objects are 

exactly the same to both eyes [5]. But if we look at an object much closer to our eyes, 

each eye sees the object with a slightly different angle. This is something that is easily 

tested. If a piece of paper is held so that one of its edges touches your nose, different 

sides of the paper would obviously be seen when keeping one of your eyes open at a 

time. 

 

Wheatstone however seemed surprised that no one had documented this 

phenomenon before him. But the cause of this, as he writes, might be that any 

consideration of it was quickly discarded because they believed that if the images 

presented to each eye were ever different, the difference would be too small to be 

taken into account. Although, Wheatstone found an article among the works of 

Leonardo da Vinci where he observes that objects in a painting can never feel as real 

as natural objects. To test what da Vinci meant, hold up a finger in front of your eyes 

and focus on an object or shape in the distance, and then move the finger left and right 

in front of your eyes so it passes over the object. The finger will never cover any part 

of that object. This of course works only when both of the eyes are kept open. In a 

painting, everything behind an object is hidden. 

 

Wheatstone had established that we see three dimensional objects because the 

eyes are presented with slightly different images. He wanted to know what the result 

would be if similar images were presented to each eye while they were projected on a 

flat surface. Wheatstone writes, after mentioning the difficulties the eyes can have 

when trying to adapt while each of them are looking at different images: 

 

“These inconveniences are removed by the instrument I am about to describe; the 

two pictures (or rather their reflected images) are placed in it at the true concourse of 

the optic axes, the focal adaptation of the eye preserves its usual adjustment, the 

appearance of lateral images is entirely avoided, and a large field of view for each eye 

is obtained. The frequent reference I shall have occasion to make to this instrument, 

will render it convenient to give it a specific name, I therefore propose that it be called 

a stereoscope, to indicate its property of representing solid figures.” [5]. 

 

He created an instrument that would present each eye with a different image. 

This was a rather big construction with moveable panels and mirrors, but it would 

allow the user to adjust the distance of the two mirrored images so that when looking 

at them they would be placed where the optic axes of the eyes intersect. When the 

right distance was found, there would be no strain to the eyes and the two images 

would be seen as one. Different images were used by Wheatstone to try his invention, 

and he found that it indeed gave the user the feeling of looking at an object of three 

dimensions. 
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2.2 Different techniques 

To view images or animations in stereoscopy the eyes need to be somehow presented 

with two slightly different images, one for each eye. There exist several different 

techniques to achieve this and through that experience the stereoscopic effect. It can 

be achieved by just using your eyes or one of several aids, such as a pair of three 

dimensional (3D) glasses. For each viewing technique the stereoscopic material needs 

to be specifically made for it. Below there will be a brief explanation of several 

common and popular techniques, and a more detailed description of anaglyphic 

stereoscopy. 

 

A significant difference between the methods is the price, which is more 

important between the methods that use some kind of 3D-glasses and are suited for a 

bigger audience. 

 

2.2.1 Common methods 

There are other methods for showing the stereoscopic effect in addition to the 

anaglyphic, and although this report focuses on the anaglyphic method there is a short 

explanation of a few other common and popular methods below to provide some 

insight to different methods of experiencing stereoscopic material. Some of these are 

suited for only one viewer at a time, while there are different types of 3D-glasses that 

work for a larger audience: 

 Side by side – A very simple method to experience stereoscopic 3D is to have 

two separate images placed side by side, as in Figure 1, where the perspective 

for one of the images represent the left eye and the perspective for the other 

image represent the right eye. These images can usually be viewed as they are, 

without use of any additional tools. The two images can be placed on either 

side of each other. The only difference is the way of viewing them. If the 

image that is made for the left eye is placed on the left side of the two, they are 

meant to be looked at by keeping the eyes parallel. If the left eye image is 

instead placed on the right side, the two images are meant to be viewed by 

crossing the eyes. Using the wrong viewing method (for example the parallel 

method when the image is made for cross-eyed viewing) will reverse the 

stereoscopic effect [3]. Things that are supposed to look like they are closer to 

the viewer will instead look further away. These images are also for use with a 

stereoscope. Looking through a proper stereoscope creates much less strain for 

the eyes, and there will be less distraction for the viewer. 

 Autostereogram – Similar to the images that are made for cross-eyed viewing, 

the autostereogram images show a three-dimensional depth when the right 

viewing technique is used to look at them. Though, as shown in Figure 2, they 

can sometimes be hidden behind what seems to be a totally random mess of 

colors. This “mess” is actually not so random for it is a repeated pattern that 

conceals the three-dimensional objects [6]. Figure 3 shows an image which is 

not hidden with a pattern which is an image of a chessboard where the pieces 

are repeated horizontally. By using the parallel viewing technique, a 

stereoscopic effect will be created as the adjacent pieces merge together. This 

is also how the images with a random pattern work. By using a z-depth image 

(where objects closer to the camera is lighter and objects further away darker) 

of a 3D object or scene, shown in Figure 4, the final image is calculated and 

hidden behind either random dots or a pattern [7]. 

 Polarized 3D-glasses – Polarized stereoscopy is when two projectors project 

images onto a silver or aluminum covered screen, where the orientation of the 

electric field of the light from the projectors has been specified [8]. When 
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using this method to show stereoscopic material, there are two methods how 

the light is polarized: linearly and circularly. The electric field of the linearly 

polarized light is directed horizontally and vertically from the projectors, and 

the viewer wears a pair of 3D-glasses which passes through light from only 

one direction for each eye. If the glasses are tilted their polarization will no 

longer match the polarization of the light and a bleeding effect between the 

two images will occur. This is avoided when using circularly polarized light 

and glasses. The light is then directed in a circular motion, either leftwards or 

rightwards, which remains even if the glasses are tilted to either side. 

 Liquid crystal shutter glasses – By alternately shutting the view at a high rate 

for the left and right eye, the two eyes can be given images with different 

perspectives and through that create the stereoscopic effect. The glass that is 

used in these glasses contains liquid crystal and a polarizing filter which 

blocks the view by turning black when you apply voltage to them [9]. The 

glasses are synchronized to the update frequency of the viewing source to 

continuously provide the correct perspective for the eyes. If the update 

frequency is not high enough, a certain amount of flickering or ghosting might 

be noticed. Ghosting is when one of the eyes sees a bit of the image meant for 

the other eye. 

 Infitec glasses – “INFITEC is a new technique to display stereoscopic images 

where the image information is transmitted in different wavelength triplets of 

the visible spectrum of light” [10]. The technique divides the visible color 

spectrum into six parts, two for each of the three primary colors; red, green 

and blue [2]. One part from each of these colors is meant for the left eye while 

the other part is for the right eye. This will provide slightly different colors to 

each eye (a display method is needed to be used where the primary colors have 

a very narrow bandwidth), but the eyes are not sensitive enough to notice the 

small spectral differences, and the technique is therefore able to show full 

color images. 

 

 

 

Figure 1: A stereogram made for parallel viewing. 
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Figure 2: An autostereogram created with Maya, Photoshop and Stereogram Maker 

[11]. 

 

 

Figure 3: A single image stereogram of a chessboard with pieces, created by 3Dimka 

(permission granted for unrestricted use). 
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Figure 4: A z-depth image used in the creation of a random dot stereogram. 

 

2.2.2 Anaglyph method 

To create anaglyphic material images are needed from two cameras with slightly 

different perspective, one for each eye. These images are given different colors from 

the three primary colors; red, green and blue. The most common combination, red and 

cyan, use only the red color channel for the left image and the green and blue channels 

(making it cyan) for the right image. The images are then placed on top of each other 

to create one image in which the stereoscopic effect can be seen by using glasses with 

the correct color filters. The filters are red for the left eye and cyan for the right eye, 

similar as the images. However, by restricting the colors seen by each eye, full color 

images are never able to be achieved. You will always be partially colorblind [12]. 

There are different colored filters that can be used, but the idea for all of them is the 

same which is to block or allow certain colors for each eye and through that present 

the eyes with two different images. A few examples of other color combinations, other 

than red and cyan, are red and blue, red and green, brown and dark blue. However 

from now on, the red and cyan filter combination is the one that will be explained. 

 

The red and cyan combination is a color anaglyph that provides a bright image, 

but it is not good at showing the red color. When viewing the composed images 

without glasses, full color images can be seen because they include all three primary 

colors, and around the edges a bit of the red or cyan colors can be seen. While wearing 

the glasses, these colors will change somewhat. Through the red filter, only the grey 

shades between black and white are seen. Through the cyan filter, the colors ranging 

from green to blue will be seen. A small experiment with colors, Figure 5 to 9, shows 

what can be seen through the glasses while looking at a correct anaglyphic image. 

This is if the color filters work perfectly, creating no color bleeding between the 

images. Some filters allow a bit of red color bleeding on purpose to achieve richer 

colors [12]. 

 

Anaglyph is the method chosen for the project that is being created because it 

requires the least amount of additional tools to be experienced; only a pair of cheap 
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3D-glasses and it can then be shown on any projector, television or computer screen. 

Therefore, it is also the most available method. The loss of some colors is an accepted 

side effect. It allows the experimenting of what is possible to show and what is not, 

and it is something that does not need to be thought about when using methods that 

can show full colors (such as the Infitec method, which will also be utilized for the 

final movie). The anaglyph method is still one of the most popular methods outside of 

theaters. 

 

 

 

Figure 5: The left and the right images as they have been rendered from Maya, placed 

next to each other in Photoshop. 

 

 

Figure 6: Red and cyan colors applied to the images. 

 

 

Figure 7: The red and cyan image as shown for left eye when wearing anaglyph glasses. 

The image was created by setting all channels of the red and cyan image to 100% red. 
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Figure 8: The red and cyan image as shown for the right eye, through the cyan filter. 

This was created by setting the red color in the red channel to 0% and increasing the green 

and blue color in the red channel from 0 to 50%. 

 

 

Figure 9: The left and right images combined (although here the left image has been used 

for both colors to not create ghosting). This is what is seen if the red and cyan filters block the 

colors perfectly, creating no color bleeding. 

 

3 The project 

The research project will result in a short 3D-modeled and animated stereoscopic 

movie created with Autodesk Maya 2009. It will take advantage of the new plug-in 

that is included in the latest version of Maya which contains expanded tools to create 

and render stereoscopic material [13]. The plug-in includes a set of stereoscopic 

cameras that will help to make the creation of stereoscopic material easier. All the 

modeling and animation is being created for this project and it will have a gladiator 

theme, similar to the gladiators fighting in amphitheaters in the early first century.  
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While this report will mainly focus on the part that is important when creating 

stereoscopic movies such as setup, placement and movement of the cameras, and 

animation of the scene, it will also explain the work before and after. This includes 

planning, choice of theme, modeling and post-production. The resource for 

information about functions inside Maya, used during this section of the research, if 

other resource is not specifically mentioned, is the Autodesk Maya Online Help [14]. 

 

3.1 Planning 

Before this research started there already existed an idea for the project. The idea was 

established after brainstorming, where several scenes, characters and plots had been 

considered. The resulting movie is meant to provide the feeling of a stereoscopic 

effect in a pleasant viewing. The idea for this animated movie is therefore a 

gladiatorial fight inside a smaller arena. 

 

That which achieves the greatest effect is those objects which come closer to the 

camera and provides the feeling that they are outside the screen in front of the 

spectator. There are some objects in the movie that will have the main task of doing 

this. The arms of the gladiators with the swords and shields that they are carrying will 

be noticed the most. Next, it is the gladiators as a whole that will be noticed. When 

one of the gladiators has lost, the well known concept with the thumb up or down will 

be used, and this arm will protrude from the screen. There will also be an occurrence 

of this in the introduction, when presenting the title of the movie. The remaining scene 

will provide a feeling of depth, however the above items are the ones that will have 

the major focus. 

 

Two gladiators will be needed, which supposed to fight against each other. While 

this movie will not claim to be historically correct, it will still be based on some of the 

historical information available. Certain types of gladiators were usually matched 

against each other, to make the fights as even as possible, and these gladiators had 

both strengths and weaknesses against one another. The gladiator types chosen for this 

project are the Murmillo and the Thracian which were two common types and they 

also often fought against each other [15]. Concept images were made of these two 

gladiators to decide what kind of armor they were going to wear. The Murmillo, which 

is shown in Figure 10, would wear an armguard that covered his whole right arm, a 

bronze helmet, a thick leather belt, a loincloth and one boot on his left leg reaching his 

knee, which would protect him below his shield. The shield he would carry would be a 

large rectangular shield that could cover most of his body. He would also carry a 

sword with him, a gladius.  
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Figure 10: Concept image of the Murmillo gladiator. 

 

The Thracian, as shown in Figure 11, was a lighter armored gladiator. He would 

wear an armguard on his right arm that covered up to elbow, a steel helmet covering 

his whole head, a loincloth with a belt holding it up and two high boots which would 

cover most of his legs. He also carried with him a small round shield and a curved 

sword. His sword was called a sica and with it he could try to get around the big shield 

carried by the Murmillo and stab him. 

 

 

 

Figure 11: Concept image of the Thracian gladiator. 

 

The arena was meant to be a smaller type of amphitheater, much smaller 

compared to the huge and well known Roman Coliseum. In the movie Gladiator 

(2000) there is a smaller arena where the character that is played by Russell Crowe, 
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together with other slaves, fight against gladiators. This arena provided much 

inspiration for the project. While this is a Hollywood produced action movie, there are 

not many depicted amphitheaters, therefore this arena would act as reference during 

the modeling. 

 

A storyboard was made where the main plot was decided. Briefly, the movie will 

start outside the arena and the camera will move in through the main door. There 

inside the Murmillo will stand waiting before he enters the arena floor. As he enters 

the Thracian does the same on the opposite side of the arena. They will fight against 

each other, and this is where most of the stereoscopic effects will be noticed. Their 

arms and weapons will swing past the camera as they dodge and block each other’s 

hits and punches. To make this action not happen too fast some of the swings will 

progress in slow motion. The movie should also be able to be watched by all age 

groups and therefore will not contain any blood. All swings will be parried, blocked, 

dodged or absorbed by the armor. They will however make a few punches with the 

shield, and that is also how one of them will stand as the winner. The Murmillo will 

land a massive hit on the Thracian, with his shield, that will knock him out. The 

Murmillo will be shown the thumb up, telling him to spare the Thracian, and he will 

start walking out of the arena. 

 

The entire movie was planned to be a maximum two minutes, where the focus 

would be on the fighting scene. After making a very generously divided time 

schedule, the fighting scene was allowed a whole minute. It was soon obvious that the 

finished movie might be shorter. 

 

3.2 Modeling 

The modeling process started with the gladiators. The gladiator of the Murmillo type 

in Figure 12 was made first on the basis of the concept images. The bodies of the two 

characters were made by starting from a single primitive, creating a cube that is two 

subdivisions wide, selecting one half of the faces and deleting those, and then 

duplicating the remaining half making the new copy an instance of it. That way 

anything that is done to either half is mirrored between them. By putting one of the 

halves in its own layer, it can be set as a Reference and there is only a need to focus on 

the other half while modeling. From there Extrude, Insert Edge Loop and Split 

Polygon are the main tools in creating the character. By using Extrude, a rough 

version of the character was made, and it was refined with Split Polygon and Insert 

Edge Loop tools. 
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Figure 12: The Murmillo gladiator, almost ready to be animated. 

 

The armor was modeled by using the already made body parts. The armguard 

was made by using the arm and the belt was made by using a part around the belly, 

and so on. Additional details were then added to them, such as buckles for the belt, 

straps for the armguard, and kneepads for the boots. When all parts of body, clothes 

and armor had been made the halves of each were combined with their respective half 

and the adjacent vertices in the middle, along the Z-axis, were merged. Then the 

objects were softened once, and this also resulted in the characters having a quite high 

polygon count. The Murmillo has around 50,000 faces, and the Thracian a little less 

with about 43,000. When the models were finished, they were UV mapped and 

assigned new materials. Most of the textures for the models were not created but come 

from various free resources on the Internet. Adobe Photoshop was used for image 

editing, when it was needed, and the textures were saved as either TIFF or Photoshop 

format. 

 

To make the second gladiator, the Thracian type that is shown in Figure 13, the 

body of the first gladiator was duplicated and from there edited to produce an 

individual appearance between the two gladiators. He was made thinner and a new 

face was created. Neither of the gladiators had hair, but the major part of their heads 

were covered by their helmets. New clothes and armor was made for the Thracian to 

suit his style. Weapons and shields were made for both gladiators according to what 

they were supposed to carry. 

 

The making of the arena started out as a simple Polygon Pipe, with two planes as 

ground; the arena floor being a bit lower than the ground outside the arena. A main 

building was made (Figure 14) where the noblemen would stand and watch the arena 

games. Audience stands were made along the top of the ring. Many parts of the arena 

are repeated around most of the ring, such as all the wooden beams holding the cloth 

roof. Therefore during the modeling they were only placed out to cover one fourth of 

the arena, and then quickly duplicated out to cover the rest. This way the arena was 

divided into 20 parts, these parts will be called slices from now. 
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Figure 13: The modeled Thracian gladiator. 

 

 

Figure 14: A rendered image of the finished arena. 

 

The main building was covering a little more than one slice and therefore cloth 

roof would be above the rest. A polygon plane was created and placed as roof for one 

of the slices. Using the Soft Modification Tool, the roof was made to give the 

impression it was hanging from the wooden beams. With Duplicate Special, the now 

created roof was duplicated 20 times with an 18 degree rotation around Y-axis each 

time (360/20=18). Important item to notice is that before any parts of the arena were 

duplicated they had been UV mapped and given textures. The same kind of 

duplication was made for the audience after they had been created for one of the 
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slices. A base model was created first. This model was placed out to cover the stands 

of one slice, and each of the models was scaled randomly. Since the base model was 

made with a few different pieces of clothes, they were now randomly deleted from the 

audience. Some of them would wear a coat, some had belts and some only the basic 

dress. A few Lambert materials were made with different colors and assigned to the 

clothes of the audience to create more randomness. Even though one of the characters 

in the audience contain only about 1000 faces they were duplicated to be almost 500 

of them around the arena, and this increased the polygon count a great deal. They will 

not be animated in any way, and if looking at the audience, they are also duplicated for 

each slice. However, as there will be no focus on them in the final movie they are just 

background, and hopefully this will not be so noticeable. The ground outside the arena 

was mostly left empty. With Sculpt Geometry Tool, some elevation in the ground was 

made to not leave it completely flat, and outside the main entrance a few rocks and 

bushes were created since this part will be visible on close distance in the movie. 

 

3.3 Preparing to animate 

For the rigging of the gladiators, the FBIK example within Maya was imported 

(Skeleton > Full Body IK > Get FBIK Example). The scale of the scene and the 

characters were increased to match the larger scale of the skeleton. Before the skeleton 

was bound to the character, the joints were moved to be in the correct places of the 

body mesh, since it was a finished skeleton that was imported and not specifically 

made for the models. Using the Smooth Bind option, the skeleton was bound with 

Max influences set to three and the Dropoff rate set to four, and leaving the box for 

Maintain max influences unchecked. The skeleton was bound to the body, the 

armguard, the belt and the boots. The helmet was Parent Constrained to the head joint, 

and so were the eyes. Since the heads of the gladiators are covered by their helmets, 

they will not have any facial expressions animated. The loincloths of both gladiators 

were to be made into nCloth, starting with the Murmillo. His loincloth was converted 

to nCloth and his body was made a Passive Collider. The upper edge of his loincloth 

and the lower edge of his belt were nConstrained Component to Component to make 

the loincloth hang from the belt. For the loincloth of the Thracian, only the part below 

the belt would be made into nCloth. Therefore, on the first edge below the belt, Detach 

Component was used. This lower part of the loincloth was made into nCloth, the body 

and the boots of the Thracian were made Passive Colliders and the upper edge of the 

loincloth was constrained back to its original edge. 

 

The camera that will be used during the rendering is the Stereo camera that is 

available through the new plug-in. The stereo plug-in needs to be loaded first, through 

the Plug-in Manager inside Maya 2009. The plug-in is named stereoCamera.mll. This 

plug-in is not available for earlier versions of Maya. There are however other plug-ins 

for the same purpose of creating a stereoscopic set of cameras but they will not be 

discussed here. When the plug-in is loaded, it will be easy to add new stereo camera 

rigs through Create > Cameras > Stereo Camera. This will add three cameras next to 

each other at the center of the scene. In the Outliner, a new camera object with the 

default name stereoCamera will appear. A new stereo camera rig can also be added 

through the viewport menu Panels > Stereo > New Stereo Camera. This will create a 

new camera and set the current perspective through the center camera of the new rig. 

It will also not place the cameras at the center, but a short distance from and above it, 

aiming towards the middle of the scene. That is also the method for changing the 

perspective to any of your created stereo cameras; through Panels > Stereo. They are 

not available through Panels > Perspective. Any of the three cameras in the rig can be 

chosen as perspective. However, only by choosing Panels > Stereo > stereoCamera 

(assuming the default name is used) the new Stereo menu will appear on the left side 
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of the Panels menu in the viewport. Through this menu a few options can be selected 

that apply to this perspective view: 

 

 Center Eye – Center Eye is the view seen with a normal camera. The 

difference is that the background is now black instead of the default grey color 

of other perspectives (see below for more about background color, as it is one 

of the last options of this Stereo dropdown menu). 

 Active – The Active mode is for use with certain graphics cards. It will only be 

available if using a NVIDIA Quadro graphics card where the stereo mode has 

been turned on. A monitor with a high update frequency and a pair of LCD 

shutter glasses that will connect to the output signal of the graphics card is also 

needed. 

 Horizontal Interlace – This mode is used with a pair of polarized 3D glasses. A 

polarized display is also required. Since the left and the right camera is 

interlaced, each horizontal row of pixels alternating between left and right 

camera, the actual vertical resolution will only be half of what is set. 

 Checkerboard – Similar to Horizontal Interlace, Checkerboard alternates 

between the cameras, but the difference is that it alternates in the horizontal 

direction also, which creates a pattern that is similar to a checkerboard. This 

also means that only half of the resolution both vertically and horizontally is 

obtained. Except 3D glasses, a DLP (Digital Light Processing) display is 

needed to view it, which is either a standalone front projector or a rear 

projection television [16]. 

 Anaglyph – With Anaglyph mode in Maya the left camera is given a red color 

filter, and the right camera is given a cyan filter. Maya automatically 

composites the two color layers, making it possible to view the stereoscopic 

effect in the viewport during the working process, while wearing a pair of 

inexpensive anaglyphic 3D-glasses. 

 Luminance Anaglyph – This is almost the same as the Anaglyph mode, except 

all colors are here shown and rendered (when rendering the current frame) in a 

grayscale. The cameras still has their red and cyan color filters. 

 Freeview (Parallel) – The Freeview modes does not require any 3D-glasses to 

experience. For the Parallel version, the right image is intended for the right 

eye and the left image for the left eye. 

 Freeview (Crossed) – In Crossed viewing mode the images change places, 

compared to Parallel; the right image is intended for the left eye and the left 

image for the right eye. These Freeview modes are the easiest method to view 

the stereoscopic effect on the screen while working, if not using anaglyphic 

3D-glasses. But it is going to put a lot of strain on the eyes. 

 Background Color … – The background color can be specified for the stereo 

perspective, instead of the default, black color. Black is a color that will 

provide a good contrast to other colors, such as the red and cyan filter of the 

Anaglyph mode. 

 Set Color Using Preferences – This will set the background color to the color 

that is specified in Preferences (Window > Settings/Preferences > Color 

Settings, General tab, 3D Views) and by default it is the light grey color that is 

seen in all perspective views. 

 

The Anaglyph mode is what will be used during the project, and therefore the other 

modes will not be discussed further. 

 

When you have created a stereo camera rig, there are several attributes that need 

to be considered while animating. These attributes control the behavior of the right 

and the left cameras, and by using these with the correct approach, the stereoscopic 
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effect is decided. These attributes can be found by selecting the stereoCamera object 

that was created. Notice also that all attributes that are changed for the middle camera 

will also change at the same time for both the left and right camera, since they are 

bound to each other by expressions. The stereo camera rig has, in addition to these 

stereo attributes (which are shown in Figure 15), all the normal camera attributes. 

 

 

 

Figure 15: The stereo camera attributes 

 

3.3.1 Stereo 

In the Stereo section of the Attribute Editor, once the stereoCamera object (and the 

stereoCameraCenterCamShape node in the Attribute Editor) is selected, there are three 

important attributes. 

 

The attribute named Stereo opens up a dropdown menu where you can select 

which method Maya should use when calculating the zero parallax plane: 

 

 Off – The Off alternative turns off the stereo effect, making the camera work 

like a normal camera, and disables the other stereo attributes. 

 Converged – By selecting the Converged method, the left and the right camera 

will turn when changing the value of the Zero Parallax (check below how Zero 

Parallax works), similar to when crossing the eyes. But since the cameras 

render rectangular (or square, depending on the resolution that is set) images, 

the perspective of the two cameras, and also the size of objects that are not 

exactly in the center, will be different. An object on the right side of the image 

will look larger in the right camera than it does in the left camera. The 

Converged method should therefore not be used when there are objects on 

either the left or the right side of the image. 
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 Off-axis – The Off-axis alternative is selected by default. When changing the 

Zero Parallax, the cameras will not turn to decide where the left and the right 

view cross. Instead the views are moved towards or away from each other, 

without changing the perspective. This is the alternative that is used most often 

and which usually gives the best result. 

 Parallel – When selecting the Parallel alternative, Zero Parallax will no longer 

have any effect; the left and the right camera will always be parallel to each 

other, and therefore the views of the two cameras will not cross. This is a 

useful alternative when creating a stereoscopic effect for a landscape that is far 

into the distance. 

 

Below the Stereo dropdown menu is the slider to set the Interaxial Separation. 

This number determines the distance between the center of the left and the right 

camera. When a new camera is created, the default distance is 6.35 centimeters which 

symbolize the average distance between the human eyes. 

 

Zero Parallax determines the plane where the view of the left and the right 

cameras cross. This is where everything looks the same in either of the two cameras 

and no actual stereoscopic effect is created. A higher number for the Zero Parallax 

makes the cameras cross further away. Any object that is closer to the camera than this 

plane is said to have a negative parallax. And on the opposite; any object that is placed 

further away than the Zero Parallax plane has a positive parallax. 

 

3.3.2 Stereo Adjustments 

The Stereo Adjustments section contains three attributes which are used less often. 

 

The Toe In Adjust will manually turn the cameras toward or away from each 

other, and works the same as the Zero Parallax when the Converged viewing method 

is selected above. It is also possible at this point to separate the cameras past being 

parallel, but this is not recommended as the human eyes do not go past being parallel 

(with a bit of practice it is possible to slightly diverge your eyes) [17]. 

 

There are two attributes for the Film Offset, one for the right camera and one for 

the left. It moves the image of either camera (left or right camera, depending on which 

attribute that is changed) to the right or the left. A positive number moves the image to 

the left, and a negative to the right. This is something that can be used if there is an 

object on one side of the view that falls a bit outside one of the cameras; the object 

might be cut off in one camera while the other camera sees it as a whole. But have in 

mind that changing the offset when animating will change the stereoscopic effect of 

the whole image. 

 

3.3.3 Stereo Display Controls 

The Stereo Display Controls does not change the behavior of the cameras, but it 

allows the user to add some visual feedback to them in the viewport while working as 

seen in Figure 16. 

 

Display Near Clip allows for showing an outline where the position of the near 

clip plane for the camera is located. The dropdown menu allows choosing for which 

cameras this outline will be visible and any of the cameras can be chosen or all of 

them together. 
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Display Far Clip performs the same as Display Near Clip. It shows an outline 

where the far clip plane is located. 

 

Display Frustum can be enabled for one or more of the cameras in the rig, which 

will draw lines out along the four corners from the camera, helping to visualize what is 

seen in the camera when not directly looking through it (for example when working in 

the perspective view). 

 

The Zero Parallax Plane will show, when enabled, a very helpful plane where the 

left and the right cameras cross at the zero parallax. Unfortunately, the plane is red and 

transparent, and will interfere with the red color in anaglyph mode. To solve this, the 

plane can be set to be fully transparent, which will only leave the outline of the plane 

visible, or the color of it can be changed. 

 

The Safe Viewing Volume shows a transparent volume object in the viewport. 

The sides of this volume indicate what is visible inside both the left and the right 

camera, making it an excellent feedback tool when working in the perspective view. 

The default color choice for this volume may also interfere with the anaglyphic 

stereoscopy, but can be changed or made fully transparent too. 

 

 

 

Figure 16: The visual aids for the camera in Maya; the blue area representing the Safe 

Viewing Volume and the red rectangle being the Zero Parallax Plane. 

3.4 Animating 

After creating a new stereo camera rig for the scene, the distance between the left and 

the right camera had to be scaled down correctly, since the scale of the scene was 

much smaller and the default 6.35 centimeters was too big. There was no object in the 

scene that could be said to have an exact length, making the scale of the scene harder 

to determine. By measuring one of the gladiators, he was found out to be 17.8 

centimeters tall. 10 times taller he would have quite an average height for human 

males at 178 centimeters [18]. With this, the scene was determined to be 1/10 of an 

actual scale, and that makes the new default distance between the cameras 0.635 
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centimeters. The Zero Parallax is also set to 1/10 of 254, as standard for this scene; to 

25.4, as it otherwise was very far away from the camera. The Zero Parallax plane, 

when turned on, represents the screen [19]. By adjusting the Zero Parallax, you can 

decide what is at the level of the screen, and what is behind it or in front. For best 

effect the objects should not be closer than halfway between the Zero Parallax Plane 

and the camera. The Far Clip Plane was increased from 1000 to 10000 (the high 

number is not so specific and it can be set higher or lower, just make sure the camera 

covers the whole distance of the scene) and as a result no objects would be in risk of 

getting cut off if they were too far away from the camera while the whole scene was 

visible. 

 

3.5 Rendering 

When the scene is ready to be rendered, after finishing the animation, there is not 

much that is different from rendering normal non-stereoscopic images. In the Render 

Settings, under Renderable Cameras, any or all three of the cameras in the stereo rig 

can be selected. By selecting stereoCamera (Stereo Pair), Maya will render out both 

the left and the right cameras. After starting Batch Render, if both cameras are 

rendered at the same time, the images from the left and the right cameras will end up 

in their own folders within the images folder. The rendered images will not have the 

red and cyan color filters already applied to them, if the expected outcome was that 

when rendering the anaglyphic images. This is instead something that needs to be 

done during the post-production. That allows for color correcting the images if 

desired, without messing up the filter colors. 

 

 For the project, the Render Settings were experimented with a little, to find a 

good balance between quality and rendering time, as there are two cameras and twice 

as many frames than normal to render. The resolution used for the final rendered 

images was set to 1024 by 768 pixels. 

 

3.6 Post-production 

The post-production for the project is made with Adobe Premiere Pro. A new custom 

project was made where the Timebase was set to 24 frames per second, as that was 

used during the animation, and the Frame Size was set to the same size of the rendered 

images, 1024 by 768 pixels. Since the rendered images are all in full color they need 

to be converted to red and cyan; red for all frames from the left camera and cyan for 

all frames from the right camera, and then place the corresponding left and right 

imagery on top of each other. There is a 3D-glasses effect in Premiere that is reachable 

from the effects window, Effects > Video Effects > Channel > 3D Glasses, which will 

apply the colors automatically. The images from the left and the right camera will 

need to be placed in their own tracks, and then the 3D Glasses effect can be applied to 

either track. In the Effect Controls, select the tracks for Left and Right View, and by 

setting the 3D View to Balanced Colored Red Blue an anaglyph result is achieved, as 

seen in Figure 17. However, Premiere does not use cyan color (and has no option for 

it) for the right camera images; they are instead blue. This will create some ghosting 

when viewed. 

 

The projectors that are using the Infitec technology, that the final movie will also 

be shown on, automatically divide the visible color spectrum between the left and the 

right images. There are two projectors, one that play the images from the left camera 

and one that play the images from the right. This simplifies the post-production 

slightly. The only thing that is different from a non-stereoscopic movie is that the 
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movie is made twice as wide to fit the left and the right images next to each other. 

What is needed to be remembered if changing anything in the images during post-

production, such as adding a color correction, is to change it in both of the images by 

the same amount. 

 

 

 

Figure 17: The left and the right camera images composed with Adobe Premiere to an 

anaglyphic image. Through red and cyan glasses an amount of ghosting is visible. 

 

3.7 Result 

As this report was finalized the full movie had not yet been completed. However, all 

the stages of a stereoscopic production, using the anaglyphic method, had been 

covered. The results, as presented in this section, will show the ease of creating 

anaglyphic material. 

 

The production of a modeled three dimensional scene is not different when the 

purpose is to create stereoscopic material. Everything that has a virtual depth, which is 

not just a flat wall or an empty space (where there instead is objects in front and 

behind each other), will be able to show more or less of a stereoscopic effect. 

However, it is good to think about the choice of colors during the texturing if 

anaglyphic material is going to be created. Red does not work as well as other colors 

when viewing the material with a pair of anaglyphic glasses, since that shows up as 

grey. During the production of the project red color was still used for the sake of 

experimenting with different colors and for getting a feeling of what works and what 

does not. The choice of scenery made a major part of the scene go in yellow and bright 

colors, which when viewed as anaglyph gave it a green tint since the red color was 

suppressed. 

 

Images were rendered with full color from Autodesk Maya. By using Adobe 

Premiere, this imagery was adapted to two different stereoscopic methods. The main 

target method, which this research report has been focused on, was the anaglyphic 
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one. The Infitec method was the full color alternative which did not suffer from the 

color limitations that anaglyph has. While the experience may be seen as better when 

viewing the material in full color, the stereoscopic effects are not different between the 

two methods. 

 

When the full movie has been finished it will be made available online as an 

anaglyphic movie to be experienced by using a pair of anaglyphic glasses [20]. There 

it will better show the stereoscopic effect than what can be created for this research 

report, as there is a difference between seeing it and reading about it. 

 

4 Discussion and Conclusion 

This research and project was started with little knowledge about the subject of 

stereoscopy. The project was created and aimed towards the anaglyph method, 

however, it is now clear that while modeling, animating and rendering, stereoscopic 

material is created that during the post-production is customized to suit the type of 

source that you want to show the material on. All the stereoscopic methods, except 

autostereogram, has the features in common that they require two images of slightly 

different perspectives; one image for each eye. When you render images in Maya 

using a stereo camera rig that is what is achieved. Two full color images are received 

with the resolution that was specified. Autostereogram are special. They are one image 

stereogram that relies on a repeated pattern to create the stereoscopic effect, and they 

do not use the different perspectives from the two cameras. 

 

During most of project the workflow in Maya was not different from creating 

normal non-stereoscopic movies as long as you are aware of your choice of colors 

during texturing if the final source is not able to show full color material. With the red 

and cyan anaglyphic, which has been mentioned above, you should be aware of 

restricting the usage of red color throughout the scene; a scene in which the main 

colors are blue or green will provide a result that is much closer to the actual colors 

than if yellow, red or purple colors are used. 

 

The stereo cameras that are available from the new plug-in within Maya have a 

few additional attributes which you need to know how they work; the two most 

important attributes being the Interaxial Separation and the Zero Parallax. When 

understanding what these attributes represent, and how to use them for projects, it is 

much easier to create good stereoscopic material. The visual aids that can be activated; 

the Zero Parallax Plane and the Safe Viewing Volume, are of great help when setting 

these attributes. In addition to this the plug-in allows the stereoscopic effect to be seen 

in real time in the viewport as the work progress. By using the anaglyphic viewing 

mode and a pair of anaglyphic glasses, while changing the stereo attributes, the 

resulting effect can be checked at any time. Then it is easy to see what settings are 

possible to use. 

The cost of the different methods to show stereoscopic material range from very 

cheap to very expensive, and is absolutely a subject that matters for the private home 

user. The anaglyph method is the most inexpensive choice and in addition to the 

normal television or computer screen only a pair of glasses with color filters is needed. 

Other methods that are aimed for a bigger audience require, together with the correct 

3D-glasses, special projectors or screens. 

 

The goal that was set in the beginning, to create a short animated stereoscopic 

movie, was not finished before the deadline of this research report. It was still being 

worked on intensively. All parts of the production had however been covered with one 
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technique or another, even the part of post-production which was of importance when 

making stereoscopic material. What was not covered was the adding of sound to the 

final movie, however that part is of little relevance to the subject of stereoscopy, even 

if sound and music adds a great deal to the final experience (which it does to any other 

movie also). 

 

The choice of colors throughout the scene could have been better when the result 

was targeted at the anaglyphic method. The best situation would have been if a scene 

would have been created where the main colors were blue and green, and not choosing 

a desert landscape with shades of yellow. The resulting imagery did obtain a green 

tint, but the stereoscopic effect was present, and that was the main purpose. It is 

recommended that Adobe Premiere Pro us not used if you intend to create red and 

cyan anaglyphic material, as the built in effect uses the color blue instead of cyan, and 

it has no simple functions to do this manually. There are other programs that achieves 

this better, such as Adobe After Effects. 

 

Anaglyphic stereoscopy will probably be replaced more and more, when other 

methods that can show full colors become cheaper, because of the color limitations 

that it has. However, it is a great alternative for those that want an introduction to this 

technique, and to experience and experiment with the stereoscopic effect. 
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